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INSTITUTE OF AERONAUTICAL ENGINEERING 
                                                            (Autonomous) 

Dundigal, Hyderabad - 500 043 

  

Program Outcomes 
PO1 Engineering Knowledge: Capability to apply knowledge of Mathematics, Science Engineering in the 

field of Mechanical Engineering  

PO2 Problem Analysis: An ability to analyze complex engineering problems to arrive at relevant conclusion 

using knowledge of Mathematics, Science and Engineering. 

PO3 Design/ Development of solution: Competence to design a system, component or process to meet 

societal needs within realistic constants. 

PO4 Conduct investigation of complex problems: To design and conduct research oriented experiments as 

well as to analyze and implement data using research methodologies. 

PO5 Modern Tool usage: An ability to formulate, solve complex engineering problems using modern 

engineering and information technology tools. 

PO6 The Engineer society: To utilize the engineering practices, techniques, skills to meet needs of health, 

safety legal, cultural and societal issues. 

PO7 Environment and Sustainability: To understand the impact of engineering solution in the societal 

context and demonstrate the knowledge for sustainable development. 

PO8 Ethics: An understanding and implementation of professional and Ethical responsibilities. 

PO9 Individual Team work: To function as an effective individual and as a member or leader in multi-

disciplinary environment and adopt in diverse teams. 

PO10 Communication: An ability to assimilate, comprehends, communicate, give and receive instructions to 

present effectively with engineering community and society. 

PO11 Project Management and Finance: An ability to provide leadership in managing complex engineering 

project at multi-disciplinary environment and to become a professional engineer. 

PO12 Life-Long learning: Recognition of the need and an ability to engage in lifelong learning to keep abreast 

with technological changes. 

Program Specific Outcomes 
PSO1 Professional Skills: To produce engineering professional capable of synthesizing and analyzing 

mechanical   system including allied engineering streams. 

PSO2 Design/ Analysis: An ability to adapt and integrate current technologies in the design and manufacturing 

domain to enhance the employability. 

PSO3 Successful Career and Entrepreneurship: To build the nation by imparting technological inputs and 

managerial skills to become a technocrats. 
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ATTAINMENT OF PROGRAM OUTCOMES 

AND PROGRAM SPECIFIC 

OUTCOMES 
 

 

 

Week 

No. 

 
 

Experiment 

 
Program 

Outcomes 

Attained 

Program 

Specific 

Outcomes 

Attained 

1 Conventional representation 
PO1, PO2, PO3, 

PO5 
 

PSO1, PSO2 

2 Sectional views 
PO1, PO2, PO3, 

PO5 
 

PSO1, PSO2 

3 Dimensioning 
PO1, PO2, PO3, 

PO5 

 

PSO1, PSO2 

4 Working drawings 
PO1, PO2, PO3, 

PO5 

 

PSO1, PSO2 

5 Machine elements 
PO1, PO2, PO3, 

PO5 

 

PSO1, PSO2 

6 Keys and cotter joints 
PO1, PO2, PO3, 

PO5 

 

PSO1, PSO2 

7 Riveted joints 
PO1, PO2, PO3, 

PO5 

 

PSO1, PSO2 

8 Couplings 
PO1, PO2, PO3, 

PO5 

 

PSO1, PSO2 

9 Bearings 
PO1, PO2, PO3, 

PO5 

 

PSO1, PSO2 

10 Assembly drawings-Engine parts : Stuffing box  

PO1, PO2, PO3, 
PO5 

 

PSO1, PSO2 

11 Assembly drawings :  Connecting rod and eccentric 

PO1, PO2, PO3, 
PO5 

 

PSO1, PSO2 

12 Assembly drawings:  Screw jack 

PO1, PO2, PO3, 
PO5 

 

PSO1, PSO2 

13 Assembly drawings: Machine vice and tailstock 

PO1, PO2, PO3, 
PO5 

 

PSO1, PSO2 

14 Assembly drawings Rams-bottom Safety Valve, feed check valve 

PO1, PO2, PO3, 
PO5 

 

PSO1, PSO2 
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MACHINE DRAWING THROUGH CAD LABORATORY 

  

III Semester: ME 

Course Code Category Hours / Week Credits Maximum Marks 

AME105 Core 
L T P C CIA SEE Total 

- - 3 2 30 70 100 

Contact Classes: Nil Tutorial Classes: Nil Practical Classes: 42 Total Classes: 42 

OBJECTIVES: 

The course should enable students to 

I. Understand Code of drawing practice as per BIS conventions for mechanical elements using 

AutoCAD. 

II. Practice the drawing methods for sectioning of joints, couplings, bearings, keys. 
III. Prepare assembly drawings, sectional views and bill of materials for selected assemblies. 

LIST OF EXERCISES 

Week-1 CONVENTIONAL REPRESENTATION 

Conventional representation of materials, common machine elements and parts such as screws, nuts, 

bolts, keys, gears, webs and ribs; Introduction to AutoCAD. 

Week-2 SECTIONAL VIEWS 

Types of sections, selection of section planes and drawing of sections and auxiliary sectional views, parts 

not usually sectioned. 

Week-3 DIMENSIONING 

Methods of dimensioning, general rules for sizes, and placement of dimensions for holes, centers, and 

curved and tapered features. 

Week-4 WORKING DRAWINGS 

Types of drawings–working drawings for machine parts. 

Week-5 MACHINE ELEMENTS 

Drawing of machine elements and simple parts; Selection of orthogonal views and additional views for the 

following machine elements and parts with every drawing proportion, popular forms of screw threads, 

bolts, nuts, stud bolts. 

Week-6 KEYS AND COTTER JOINTS 

Keys, cotter joints, and knuckle joint. 

Week-7 RIVETED JOINTS 

Riveted joints for plates. 

Week-8 COUPLINGS 

Shaft coupling and spigot joint. 

Week-9 BEARINGS 

Journal, pivot, and collar bearing. 

 

 

 

 

 

 

 

 

Week-10 ASSEMBLY DRAWINGS-ENGINE PARTS 
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Assembly drawings for the following, using conventions and parametric drawing practice: 

Engine parts, stuffing box. 

Week-11 CONNECTING ROD AND ECCENTRIC 

Eccentrics, I.C. engine connecting rod. 

WeeK-12 SCREW JACK 

Screw jack. 

Week-13 TAIL STOCK AND MACHINE VICE 

Machine vice and tailstock. 

Week-14 SAFETY VALVES 

Rams-bottom Safety Valve, feed check valve. 

Text Books: 

1.K.L. Narayana, P. Kannaiah, K. Venkata Reddy, “Machine Drawing”, New Age Publishers, 3
rd 

Edition, 2012. 
2. K.C. John, “Text book of Machine Drawing”, PHI Eastern Economy, 1

st  
Edition, 2010. 

3. P.S Gill, “Machine Drawing”, S.K Kataria & Sons, 1
st

Edition, 2013. 

4. Junnarkar N.D, “Machine Drawing”, Pearson Edu, 1
st  

Edition, 2007. 

5. Basudeb Bhattacharya, “Machine Drawing”, Oxford University Press, 1
st  

Edition, 2011. 
6. N. D. Bhatt, V. M Pancahal, “Machine Drawing”, Charotar, 2014. 
7. R.  K.  Dhavan,  “A  Text  book  of  Machine  Drawing”,  S.Chand  Publication  &  Co,  New  Delhi,  

2
nd 

Edition, 2008. 

Web References: 

1. http://web.iitd.ac.in/~achawla/public_html/201/sheets/sheet5/sheet5.pdf 

2. https://drive.google.com/file/d/0B_GCh7LMfHf6Z0VNWTNHU3pMSTg/view?pref=2&pli=1 

3. http://www.uiet.co.in/downloads/20140911122818-Machine20Drawing.pdf 

4. http://listpdf.com/ma/machine-drawing-book-pdf.html 

Course Home Page: 

SOFTWARE AND HARDWARE REQUIREMENTS FOR A BATCH OF 36 STUDENTS: 

 

SOFTWARE: System Software: Microsoft Windows 7. 

Application Software: AutoCAD. 

 

HARDWARE: 36 numbers of Desktop Computer Systems 

 

 

 

 

 

 

 

http://web.iitd.ac.in/~achawla/public_html/201/sheets/sheet5/sheet5.pdf
http://www.uiet.co.in/downloads/20140911122818-Machine20Drawing.pdf
http://listpdf.com/ma/machine-drawing-book-pdf.html
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DESIGNATION AND RELATIVE POSITIONS OF VIEWS 

 

An object positioned in space may be imagined as surrounded by six mutually perpendicular 

planes. So, for any object, six different views may be obtained by viewing at it along the six 

directions, normal to these planes. Figure 1.0 shows an object with six possible directions to obtain 

the different views which are designated as follows: 

 

 View in the direction a = view from the front  

View in the direction b = view from above                                   

 
                          Fig. 1.0 

View in the direction c = view from the left 

 

View in the direction d = view from the right 

 

View in the direction e = view from below 

 

View in the direction f = view from the rear 

 

Figure 1.1 a shows the relative positions of the above six views in the first angle projection and Fig.1.1 b, 

the distinguishing symbol of this method of projection. Figure 1.2 a shows the relative position of the 

views in the third angle projection and Fig. 1.2b, the distinguishing symbol of this method of projection 
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                                               Fig. 1.1                                                                       Fig. 1.2 

 

TYPES OF LINES 
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WEEK-I     -       CONVENTIONAL REPRESENTATION 

 
Exercise No. 1   Conventional Representation of Materials 
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Exercise No. 2 Conventional Representation of Common Machine Elements 
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Exercise No. 3 Conventional Representation of Machine Parts 

 

 

                                                                   (c) 
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Exercise No. 4 Conventional Representation Of Screws. 
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Exercise No. 5   Conventional Representation of Nuts And Bolts 
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HEXAGONAL HEADED BOLT WITH NUT AND WASHER 
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Exercise No. 6   Conventional Representation of Webs and Ribs 

                 

RIB 

                

WEB 

Exercise No. 7 Introduction to AutoCAD Commands 
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ICON SETTING  ICON SETTING 

Command Keystroke Icon Menu Result 

 

Line 

 

Line / L 

 

 
 

Draw > Line 
Draw a straight line segment 

from one point to the next 

 

Circle 

 

Circle / C 

 

 
 

 

Draw > Circle 

> Center, 

Radius 

Draws a circle based on a 

center point and radius. 

 

Erase 

 

Erase / E 

 

 
 

 

Modify > Erase 
 

Erases an object. 

 

Print 

 

Print / Plot Cntl+P 

 

 
 

 

File > Print 

Enables the Print/Plot 

Configuration Dialog 

Box 

 

 

Undo 

U 

 

(Don't use 'Undo' for now) 

 

 
 

 

 

Edit > Undo 

 

Undoes the last command. 

 

 

Rectangle 

 

RECTANGLE / REC 

 

 

 
 

 

Draw > 

Rectangle 

Draws a rectangle after you 

enter one corner and then 

the second. 

 

Multi Lines 

 

MLINE / ML 

 

No Icon 

Draw > 

 

Multiline 

Draw parallel lines based 

on the parameters you 

define. 

 

Trim 

 

TRIM / TR 

 

 

 

Modify > Trim 
Trims objects to a selected 

cutting edge. 

 

Extend 

 

EXTEND / EX 

 

 

 

Modify > Extend 
Extends objects to a 

selected boundary edge. 

 

Offset 

 

OFFSET / O 

 

 

 

Modify > 

Offset 

Offsets an object (parallel) 

by a set distance. 

 

Object 

Snaps 

OSNAP / OS / F3 
CLICK 

 

 

 

Tools > 

Object Snap 

Settings 

Brings up the OSNAP 

dialog box. 
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Endpoint 

  

 

 

Perpendicular 

 

 

 

Midpoint 

  

 

 

Tangent 

 

 

 

Center 

  

 

 

Nearest 

 

 

 

Node 

  

 

Apparent Intersection 

 

 

 

Quadrant 

  

 

 

Parallel 

 

 

 

Intersection 

  

 

 

None 

 

 

 

Extension 

  

 

 

Osnap Setting 

 

 

 

Insertion Point 

  

 

Temporary Tracking 

Point 

   

 

 

Snap From 

 

 

 

 

 

 

 

 

RIGHT TO 

LEFT 

 

CROSSING 

SELECTION 

GREEN 

(with a 

dotted 

outline

) 

SECLECTS ANY OBJECT THAT EITHER 

CROSSES THE BOUNDARY OR IS 

INSIDE IT 

LEFT TO RIGHT WINDOW 

SELCTION 
BLUE 

SELECTS ON OBJECTS THAT ARE 

COMPLETELY WITHIN THE BOX 
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Command Keystroke Icon Menu Result 

 

Move Move / M 
 

 

 

Modify > Move 
Moves an object or 

objects 

 

Copy 

 

Copy / CP 

 

 

 

Modify > Copy 
Copies object(s) once 

or multiple times 

 

Stretch 

 

Stretch / S 

 

 
 

 

Modify > Stretch 

Stretches an object 

after you have 

selected a portion of it 

 

Mirror 

 

Mirror / MI 

 

 
 

 

Modify > Mirror 

Creates a mirror image 

of an object or 

selection set 

 

Rotate Rotate / RO 
 

 

 

Modify > Rotate 
Rotates objects to a 

certain angle 

 

Fillet 

 

Fillet / F 

 

 

 

Modify > Fillet 
Creates a round corner 

between two lines 

 

Chamfer 

 

Chamfer / CHA 

 

 
 

 

Modify > 

Chamfer 

Creates an angled 

corner between two 

lines 

 

Array 

 

Array / AR 

 

 
 

 

Modify > Array 

Creates a repeating 

pattern of the selected 

objects 

Layer Layer / LA  

 
 

 

Format > Layer Starts the Layer and 

Linetype property 

dialog box 

Text Text No Icon Draw > Single 

Line Text 

Creates a single line of 

text 

Dimension Dim Many Dimension > 

(pick one) 

Dimensions previously 

drawn objects 

Scale Scale / SC  

 
 

Modify > Scale Proportionately 

resizes (or scales) 

objects 
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COMMAND 

OPTION 
ICON DESCRIPTION 

 

Zoom All 

 

 

This option causes AutoCAD to display the whole drawing as far as its 

drawing limits (whichever is the greater of the two). 

 

 

Zoom Center 

 

 

 

 
 

 

 

This option requires two things: a point that is to be the center of the new 

display and a value to be its new height in drawing units. The existing 

height is the default for the new height to allow for panning across the 

drawing. If the new height value is followed by "X" (eg. 2x), then it is 

taken as a magnification factor relative to the current height. If followed 

by "XP", then it is taken as a scale factor relative to paper space and can 

be used for scaling the contents of paper space viewports. 

 

 

 

 

 

Zoom Dynamic 

 

 

 

 

 

 

 

 
 

 

 

 

 

 

 

This is a very useful ZOOM option once it is understood. It permits very 

quick movement around the drawing. Once selected, this option redraws 

the graphics area of the screen and displays two rectangles. The larger 

box shows the extents of the current drawing. The smaller box shows the 

current view with an "X" in the middle. This moves with the mouse. This 

view box should be positioned so that its lower left corner is at the lower 

left corner of the view required. By pressing the left button on the mouse, 

the "X" is replaced by an "> " pointing to the right side of the view box. 

This allows you to change the magnification. As the mouse is moved, the 

view box shrinks and expands so that the size of the required view can be 

set. The left mouse button toggles between PAN "X" and ZOOM "> " 

mode so that fine adjustments can be achieved. When the view required 

has been selected, press <ENTER> or right click to cause AutoCAD to 

display it. 

Zoom Extents 
 

 

This option will display all the graphics that are contained in the drawing 

(referred to as the drawing extents) with the largest image possible. 

 

Zoom Previous 

 

 

 
 

This option restores the displayed view prior to the current one. For the 

purpose of this option, up to 10 views are saved so that the last ten views 

can be recalled. This option includes every time you use the scroll bar, 

which is one reason to avoid the scroll bars for panning a lot in your 

drawing. 
 

 

 

 

Zoom Scale 

 

 

 

 

 

 
 

 

 

 

 

This is a 'hidden' default option. You do not have to type "S" to choose 

this option. It simply requires the entry of a number that represents a 

magnification factor. Note that the factor is applied to the entire drawing 

(as defined by the drawing's limits). 

Numbers less than 1 will reduce the displayed size of the drawing, while 

numbers greater than 1 will enlarge it. If "X" is inserted after the number 

(eg. 0.8x) then the factor is applied to the current view. If "XP" is inserted 

after the scale factor, then the view is scaled relative to paper space. This 

is useful for zooming a view within a paper space viewport to a specific 

scale, for example, "1/48XP" will produce a view of model space at a 

scale of ¼" = 1' relative to paper space. 
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COMMAND 

OPTION 
ICON DESCRIPTION 

Zoom Window 
 

 

This option (also a 'hidden' default) prompts the user to pick two corners 

of a box on the existing view in order to enlarge that area to fill the 

display. 

 

 

 

 

 

 

Zoom Realtime 

 

 

 

 

 

 

 

 
 

 

 

 

 

 

 

Zoom Real time provides interactive zooming capability. Pressing 

<ENTER> (after entering zoom) on the command line automatically 

places you in Real time mode. Hold the left mouse button down at the 

midpoint of the drawing and move the cursor vertically to the top 

(positive direction) of the window to zoom in up to 100% (2x 

magnification). Hold the left mouse button down at the midpoint of the 

drawing and move the cursor vertically to the bottom (negative direction) 

of the window to zoom out to100% (.5x magnification). You cannot zoom 

out beyond the extents of the current view. 

 

When you release the pick button, zooming stops. You can release the 

pick button, move the cursor to another location in the drawing, and then 

press the pick button again and continue zooming from that location. To 

exit Real time Zoom mode, press 
<ENTER> or (ESC). 

 

 

 

 

Aerial View 

command: 

DSVIEWER 

 

 

 

 

 

None 

Aerial View is a zooming tool that displays a view of the drawing in a 

separate window so that you can quickly move to that area. If you keep 

the Aerial View window open as you work, you can zoom and pan 

without choosing a menu option or entering a command. You can change 

the view by creating a new view box in the Aerial View window. To 

zoom in to the drawing, make the view box smaller by left clicking a 

rectangle. To zoom out of the drawing, make the view box larger. As you 

zoom in or out of the drawing, a real-time view of the current zoom 

location is displayed in the graphics area. The screenshot shows how the 

view box looks. Right click in the box and you can move the box to 

where you want to zoom to. 

Zoom Object 
 

 

This option asks you to select an object or objects, then press 
<ENTER> and the screen will zoom to those objects only. This is great 

for when you want to work on object. 

 

Zoom In 

 

 

Clicking this icon will zoom in to the drawing by about 50%. This option 

is only available as an icon and cannot be invoked by the command line. 

Zoom Out 
 

 

Similar to 'Zoom In' - this icon will zoom out of your drawing and allow 

you to see about 50% more of your drawing space. 

 

 

Mouse Scroll 

 

 

- 

If you have a scrolling wheel on your mouse, you can use it to zoom in 

and out of your drawing. Scroll towards you to zoom out and away from 

you to zoom in. You have the option to change the amount of zoom per 

wheel click with the Zoom factor system variable. Keep in mind that you 

will zoom in and out using your mouse location as a 'centre point'. 
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COMMAND OPTION 
ICON DESCRIPTION 

 

PAN 

 

 

 
 

Panning allows you to quickly move around the drawing area at the same 

magnification you currently have set. Type in PAN (or 

P) <ENTER> and a hand will appear on the screen. Left click and hold 

to move around your drawing. 

 

 

Command Keystroke Icon Menu Result 

Boundary Hatch 
Bhatch / H 

 

 

 

Draw > Hatch 
Covers an area with a 

predefined pattern 

 

Hatch Edit 
HatchEdit / 

HE 

 

 

Modify > Object 

> Hatch... 

Edits an existing Hatch 
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           WEEK-II                                       SECTIONAL VIEWS 

    Orthographic views when carefully selected may reveal the external features of even the most complicated objects.  

    However, there are objects with complicated interior details and when represented by hidden lines, may not effectively  

    reveal the true interior details. This may be overcome by representing one or more of the views ‘in section’. 

A sectional view is obtained by imagining the object, as if cut by a cutting plane and the portion between the observer 

and the section plane being removed. Figure. 1 (a) shows an object, with the cutting plane passing through it and Fig. 

1(b), the two halves drawn apart, exposing the interior details. 

 

 

                                                       Fig 1 (a)                                           Fig 1(b)  

 

Fig.1.0 Principles of sectioning 



[Type text]  

 

 

 

    In order to show such features clearly, one or more views are drawn as if a portion had been cut away to reveal the 

interior This procedure is called sectioning and the view showing the cut away picture is called section view. 

     A section is an imaginary cut taken through an object to reveal the shape or interior construction.  

         Fig. 2a shows the imaginary cutting plane in perspective view. 

     The imaginary cutting plane is projected on a standard view so that the sectional view with orthographic           

     representation is obtained as shown in Fig. 2 b . 

     A sectional view must show which portions of the object are solid material and which are spaces. This is done   

     by section lining (cross-hatching) the solid parts with uniformly spaced thin lines generally at 45º. 

 

(a) (b) 

Fig. 2 sectional view 

 

 



 

 

  

 

Types of Sections  

Depending on the number of cutting planes, sectional views can be simple with one cutting plane (Fig. 3) or 

complex with two or more cutting planes (Fig.4). 

If the cutting plane-line cuts entirely across the object, it is called a full section. 

 If the cutting plane cuts halfway through the object, it is a half section. 

In addition to these, there are broken-out sections, rotated sections, removed sections, auxiliary sections, and 

assembly sections. 

 

 

 

Fig.3 sectional views can be simple with one cutting plane 

 

Fig.4 sectional views can be complex with two or more cutting planes                                                                                                                                         



 

 

 

Exercise No. 8 

Full Section 

A sectional view obtained by assuming that the object is completely cut by a plane is called a full section or 

sectional view. shown in Fig. 5.1a, in full section. The sectioned view provides all the inner details, better than 

the unsectioned view with dotted lines for inner details (Fig. 5.1b). The cutting plane is represented by its trace 

(V.T) in the view from the front (Fig. 5.1c) and the direction of sight to obtain the sectional view is 

represented by the arrows. 

    When cutting plane passes fully through an object, it is called full section  

                     
 

                                                           

                                                                          Fig. 5  Sectioned and un-sectioned views 

                        

It may be noted that, in order to obtain a sectional view, only one half of the object is imagined to be 

removed, but is not actually shown removed anywhere except in the sectional view. Further, in a sectional 

view, the portions of the object that have been cut by the plane are represented by section lining or hatching. 

The view should also contain the visible parts behind the cutting plane. 

 

 

    Figure.6   Full Sectional View 



 

 

 

Exercise No. 9 

 

Half Section 

A half sectional view is preferred for symmetrical objects. For a half section, the cutting plane removes only one 

quarter of an object. For a symmetrical object, a half sectional view is used to indicate both interior and exterior 

details in the same view. 

 A half section is made by cutting halfway through an object (Fig.  7). Thus, one half is drawn in section and 

the other half is a side view, usually, hidden lines are not used (inside details are visible on the section view). 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

                                                Fig. 7 Half Section 

Auxiliary sections may be used to supplement the principal views used in orthographic projections. A sectional view 

projected on an auxiliary plane, inclined to the principal planes of projection, shows the cross-sectional shapes of 

features such as arms, ribs and so on. In Fig.8, auxiliary cutting plane X-X is used to obtain the auxiliary section X-X                                                                     

.                                                              

                                                                    Fig. 8  Auxiliary section                                                   



 

 

 

Exercise No. 10 

 

Assembly Sections 

 
Assembly sections consist of a combination of parts. 

The purpose of an assembly section is to reveal the interior of a machine or structure so that the separate parts 

can be clearly shown and identified.  However, the separate parts do not need to be described. 

In assembly drawing, only such hidden details (as needed for part identification or dimensioning) are drawn. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Fig. 9 Assembly section



 

 
 
 
 

 

 

Exercise No. 11 

Hidden Edges and Surface in Section 

Sections are primarily used to replace hidden lines with visible lines. As a rule, hidden lines and surfaces should 

be omitted in sectional views. 

Thus, preferred sectional view should be as in Fig. 10.   

 

 In some cases, hidden edges and surfaces can be shown for describing the object 

 

 

 

 

             

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

                                                         

                                                                                       

 

 

 

 

 

                                                    Fig .10 Hidden Edges and surfaces in section



 

 
 
 
 

 

  

 

   Section Lining (Cross Hatching) 
 

 Section lining of a cut surface is indicated by fine lines, which are drawn as continuous lines usually at an 

angle of 45º with uniform distance (about 2 mm). For smaller or larger areas, distance between lines can be 

from 1 mm to 4 mm. 

Section lining or cross-hatching lines should not be parallel or perpendicular to any main visible line 

bounding the sectioned area. 

 
 

                                                           Fig. 11  Cross Hatching 
 

Ribs and webs are used to strengthen the parts. When the cutting plane passes through the ribs lengthwise, 

cross-hatching would give the misleading impression that the section was conical (Fig.12). 

 

Therefore, cross-hatching is eliminated from the ribs and webs (as if the cutting plane was just in front of 

them) when the cutting plane  passes  longitudinally through them (Fig. 12and 13). 

 

 

 

Fig. 12Web Fig. 13 Ribs Figure 32 



  

 

 Exercise No. 12 

 

 
SPOKES AND ARMS IN SECTION 

 

When a cutting plane passes through pulley spokes or arms, cross-hatching is eliminated where the 

plane is thought  

of as being just in front of the spokes. 

 

Even though the cutting plane passes through two of the spokes in Fig. 14, the sectional view in Fig. 14 

a must be made without cross-hatching the spokes in order to avoid the appearance of a solid web as in 

Fig. 1 4 b. 

 

 

 

 
 

Fig 14 Spokes and Arms 

 

 

 

 

 

 

 



  

 

 

Various cutting planes can be selected for obtaining clear sectional views 
The plane may cut straight across (Fig.15) or be offset (changing direction forward and 

backward) to pass through features.  

  

                                                

 

 

 

 

 

 

 

 

 

 

 

 

Fig. 15 : Various cutting planes obtaining clear sectional views. 
 

 

 

 

 

 

 

 

 

 



  

 

 

Exercise No. 13 

 

Draw (i) sectional view from the front, (ii) the view from above and (iii) the view from the right of the 

shaft support  

 

 

                       

 



  

 

Exercise No. 14 

 

Draw the (i) the sectional view from the front, (ii) the view from above and (iii) the sectional view from 

the left  Of the given Machine block. 

                                        

                                                                Isometric View of Machine Block 

 

 

Sectional Views 



  

 

Exercise No. 15 

Week-III       Dimensioning 

A drawing of a component, in addition to providing complete shape description, must also furnish 

information regarding the size description. These are provided through the distances between the 

surfaces, location of holes, nature of surface finsih, type of material, etc. The expression of these 

features on a drawing, using lines, symbols, figures and notes is called dimensioning. 

BASIC DIMENSIONING 

In many applications, a drawing should contain annotations showing lengths or distances or 

angles between objects to convey the desired information. Dimensioning is the process of adding 

these annotations to a drawing. AutoCAD provides four basic types of dimensioning; linear, 

angular, diameter and radius. 

DIM and DIMI Commands—DIMI command allows executing one dimensioning 

command and then returns to the normal command mode. If several dimensioning commands are 

to be executed, DIM command should be used. In this mode, the normal set of AutoCAD 

commands is replaced by a special set of dimensioning commands. To end the process of 

dimensioning, EXIT command has to be used. 

The elements of dimensioning include the projection line, dimension line, leader line, dimension 

line termination, the origin indication and the dimension itself. The various elements of 

dimensioning are shown in Figs. 1 and 2. The following are some of the principles to be adopted 

during execution of dimensioning: 

 

 

 

 

Fig. 1 Elements of dimensioning



  

 

  

 

Fig. 2 Elements of dimensioning 

  

                   

Projection and dimension lines should be drawn as thin continuous lines.  

Projection lines should extend slightly beyond the respective dimension lines.  

Projection lines should be drawn perpendicular to the feature being dimensioned. Where necessary, 

they may be drawn obliquely, but parallel to each other (Fig. 2). However, they must be in contact 

with the feature.  

Projection lines and dimension lines should not cross each other, unless it is unavoidable (Fig.4)  

A dimension line should be shown unbroken, even where the feature to which it refers, is shown 

broken (Fig. 5). 

A centre line or the outline of a part should not be used as a dimension line, but may be used in place 

of projection line (Fig. 6). 

 

 

Fig. 4 Fig. 5 Fig. 6 

 

 

 



  

 

Dimension lines should show distinct termination, in the form of arrow heads or oblique strokes or where  

applicable, an origin indication. Two dimension line terminations and an origin indication are shown in  

  Fig. 7. 

 

                             

                            Arrow head                                                   Oblique stroke   Origin indication 

 

                                                                         Fig. 8 

 

METHOD–1 (Aligned System) 

Dimensions should be placed parallel to their dimension lines and preferably near the middle, 

above and clear-off the dimension line (Fig. 9). An exception may be made where super-imposed 

running dimensions are used (Fig. 15 ) 

 

Dimensions may be written so that they can be read from the bottom or from the right side 

of the drawing. Dimensions on oblique dimension lines should be oriented as shown in Fig. 10. 

Angular dimensions may be oriented as shown in Fig. 11. 

                
 

 
Fig. 9 Fig. 10 Oblique dimensioning Fig. 11 Angular dimensioning 

 

 

 

 

 

 

 

 

 



  

 

METHOD–2 (Uni-directional System) 

Dimensions should be indicated so that they can be read from the bottom of the drawing only. 

Non-horizontal dimension lines are interrupted, preferably near the middle, for insertion of the 

dimension (Fig. 12).  Angular dimensions may be oriented as in Fig. 13 

           

                                    
                                                 Fig. 12 Fig. 13 Angular dimensioning 

 

Arrangement of Dimensions 

The arrangement of dimensions on a drawing must indicate clearly the design purpose. The 

following are the ways of arranging the dimensions. 

Chain Dimensions 

Chains of single dimensions should be used only where the possible accumulation of tolerances does 

not endanger the functional requirement of the part (Fig. 14). 

                                     

                                                      Fig. 14 Chain dimensioning 

 

 

 

 

 

 

 



  

 

Parallel Dimensions 

In parallel dimensioning, a number of dimension lines, parallel to one another and spaced -out are 

used. This method is used where a number of dimensions have a common datum feature (Fig. 15) 

                                                          
               Fig. 15 Parallel dimensioning 

 

Combined Dimensions 

 

These are the result of simultaneous use of chain and parallel dimensions (Fig. 16). 

 

                                                               
                            Fig. 16 Combined dimensioning 

 

 

 

 

 

 

 

 

 

 



  

 

Exercise No. 16 

 

Diameters 

Diameters should be dimensioned on the most appropriate view to ensure clarity. The dimension 

value should be preceded by φ. Figure 17 shows the method of dimensioning diameters. 

 

Chords, Arcs, Angles and Radii 

The dimensioning of chords, arcs and angles should be as shown in Fig. 18. Where the centre of 

an arc falls outside the limits of the space available, the dimension line of the radius should be 

broken or interrupted according to whether or not it is necessary to locate the centre (Fig. 19). 

 

                                   

Fig. 18 Dimensioning of chords, arcs and angles                                 Fig. 19 Dimensioning of radius    

 

  

 

 

 



  

 

 

 Equi-distant Features 

Linear spacings with equi-distant features may be dimensioned as shown in Fig. 20. 

 

Fig. 20 Dimensioning equi-distant features 

Tapered Features 

Tapered features are dimensioned, either by specifying the diameters at either end and the length, 

or the length, one of the diameters and the taper or the taper angle (Fig. 21 a).A slope or flat taper 

is defined as the rise per unit length and is dimensioned by the ratio of the difference between the 

heights to its length (Fig 21 b). 

                                                
 

                         Fig. 21  Dimensioning tapered features 

 

 

 

 

 

 

 

 

 

 



  

 

Exercise No. 17 

 

EXAMPLES 

 

Violations of some of the principles of drawing are indicated in Fig. 22 a. The corrected version 

of the same as per the BIS, SP–46: 1988 is given in Fig. 22 b and the reasons are given below: 

1. Dimension should follow the shape symbol (Fig. 22). 

2. and 3. As far as possible, features should not be used as extension lines for dimensioning. 

4. Extension line should touch the feature. 

5. Extension line should project beyond the dimension line. 

6. Writing the dimension is not as per the aligned system. 

7. Hidden lines should meet without a gap  

8. Centre line representation is wrong. Dot should be replaced by a small dash. 

9. Horizontal dimension line should not be broken to insert the value of the dimension  

10. Dimension should be placed above the dimension line  

11. Radius symbol should precede the dimension  

12. Centre lines should cross at long dashes  

13. Dimension should be written by symbol (not abbreviation) followed by its value  

14. Note with dimensions should be written in capitals. 

15. Elevation is not the correct usage. 

16.Usage of the term ‘‘plan’’ is obsolete in graphic language. 

 

                                                                    



  

 

 
 

Fig. 22 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



  

 

Week-IV       Working Drawings 

 

A production drawing, also known as working drawing, supplies information and instructions 

for 

the manufacture or construction of machines or structures. A production drawing should 

provide 

all the dimensions, limits, special finishing processes, surface quality, etc. The particulars of 

material, the number of components required for the assembly, etc., are given in the title block. 

The production drawing of a component should also indicate the sub-assembly or main 

assembly 

where it will be assembled. Since the working drawings may be sent to other companies to 

make or assemble the unit, the drawings should confirm with the standards followed in the 

country. For this reason, aproduction drawing becomes a legal document between the parties, 

in case of disputes in manufacturing.Working drawings may be classified into two groups : (i) 

detail or part drawings and (ii) assembly drawings 

Types of working Drawings 

A detail or part drawing is nothing but a production or component drawing, furnishing complete 

information for the construction or manufacture of the part. This information may be classified 

as: 

1. Shape description This refers to the selection of number of views to describe the shape 

of the part. The part may be drawn in either pictorial or orthographic projection; the latter being 

used more frequently. Sectional views, auxiliary views and enlarged detailed views may be added 

to the drawing in order to provide a clear image of the part. 

2. Size description Size and location of the shape features are shown by proper 

dimensioning. The manufacturing process will influence the selection of some dimensions, such 

as datum feature, tolerances, etc. 

3. Specifications This includes special notes, material, heat treatment, finish, general 

tolerances and number required. All this information is mostly located near the title block. 

4. Additional information Information such as drawing number, scale, method of 

projection, date, names of the parts, the draughter's name, etc., come under additional information 

which is included in the title block. 

Since the craftsman will ordinarily make one component at a time, it is advisable to prepare 

the production drawing of each component, regardless of its size, on a separate sheet. Figures1  

and 2 show the detailed drawings of a template jig and gear. 



  

 

 

 

 

 

Exercise No. 18 

                

 
 

                                                                   Fig. 1  Template Jig 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



  

 

 

 

 

 

Exercise No. 19 

 

                                             
 

 

                     Fig.2  Gear 

 

 

 

 

 

 

 

 

 



  

 

 

 

 

 

Exercise No. 20 

 

 
 

Fig. 3 Crank 

 

 

 



  

 

 

 

 

 

Exercise No. 21 

 

Week-V   MACHINE ELEMENTS 

 

FORMS OF THREADS 

 

Bureau of Indian Standards (BIS) adapts ISO (International Organisation for Standards) metric 

threads which are adapted by a number of countries apart from India. 

 

The design profiles of external and internal threads are shown in Fig. 1. The following are 

the relations between the various parameters marked in the figure : 

 

 

 
 

 

 

 

 



  

 

 

Other Thread Profiles 

 

Apart from ISO metric screw thread profile, there are other profiles in use to meet various 

applications. These profiles are shown in Fig. 5.3, the characteristics and applications of which 

are discussed below : 

V-Thread (sharp) 

This thread profile has a larger contact area, providing more frictional resistance to motion. 

 

Hence, it is used where effective positioning is required. It is also used in brass pipe work. 

British Standard Whitworth (B.S.W) Thread 

 

This thread form is adopted in Britain in inch units. The profile has rounded ends, making it less 

liable to damage than sharp V-thread. 

 

Buttress Thread 

 

This thread is a combination of V-and square threads. It exhibits the advantages of square thread, 

like the ability to transmit power and low frictional resistance, with the strength of the V-thread. 

It is used where power transmission takes place in one direction only such as screw press, quick 

acting carpenter’s vice, etc. 

 

Square Thread 

 

Square thread is an ideal thread form for power transmission. In this, as the thread flank is at right 

angle to the axis, the normal force between the threads, acts parallel to the axis, with zero radial 

component. This enables the nut to transmit very high pressures, as in the case of a screw jack 

and other similar applications. 

ACME Thread 

 

It is a modified form of square thread. It is much stronger than square thread because of the wider 

base and it is easy to cut. The inclined sides of the thread facilitate quick and easy engagement 

and disengagement as for example, the split nut with the lead screw of a lathe. 

 

Worm Thread 

 

Worm thread is similar to the ACME thread, but is deeper. It is used on shafts to carry power to 

worm wheels. 



  

 

 

 
 

Fig. 5.3 Types of thread profiles 

 

RIGHT HAND AND LEFT HAND THREADS 

Screw threads may be right hand or left hand, depending on the direction of the helix. A right 

hand thread is one which advances into the nut, when turned in a clockwise direction and a left 

hand thread is one which advances into the nut when turned in a counter clockwise direction. An 

abbreviation LH is used to indicate a left hand thread. Unless otherwise stated, a thread should be 

considered as a right hand one. Figure 5.5 illustrates both right and left hand thread forms. 

 

 
 

Fig. 5.5 Right hand and left hand threads 

 

 

 

 

 

 

 

 

 

 



  

 

BOLTED JOINT 
 

Nuts in general are square or hexagonal in shape. The nuts with internal threads engage with the 

corresponding  size of the external threads of the bolt.  However, there are other forms of nuts used to 

suit specific requirements. For nuts, hexagonal shape is preferred to the square one, as it is easy to 

tighten even in a limited space. This is because, with only one-sixth of a turn, the spanner can be re-

introduced in the same position. However, square nuts are used when frequent loosening and 

tightening is required, for example on job holding devices like vices, tool posts in machines, etc. The 

sharp corners on the head of bolts and nuts are removed by chamfering. 

 

                                                           Fig. 5.11 Bolted joint 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



  

 

 

 

Exercise No. 22 

 

 

        Methods of Drawing Hexagonal (Bolt Head ) Nut 

 
          Drawing hexagonal bolt head or nut, to the exact dimensions is labourious and time consuming. 

Moreover, as standard bolts and nuts are used, it is not necessary to draw them accurately. The following 

approximate methods are used to save the draughting time 

 

Method 1 (Fig. 5.12)  

Empirical relations :  

Major or nominal diameter of bolt = D 

Thickness of nut, T = D 

Width of nut across flat surfaces, W = 1.5D + 3 mm 

Radius of chamfer, R =1.5D 

 

 
 

Fig. 5.12 Method of drawing views of a hexagonal nut (Method I) 

 

 

 

 



  

 

 

PROCEDURE 

  Draw the view from above by drawing a circle of diameter, W and describe a regular 

hexagon on it, by keeping any two parallel sides of the hexagon, horizontal.  

  Project the view from the front, and the view from side, and mark the height equal to D.  

  With radius R, draw the chamfer arc 2-1-3 passing through the point 1 in the front face.  

  Mark points 4 and 5, lying in-line with 2 and 3.  

  Locate points 8,9 on the top surface, by projecting from the view from above.  

  Draw the chamfers 4–8 and 5–9.  

  Locate points 6 and 7, lying at the middle of the outer two faces.  

  Draw circular arcs passing through the points 4, 6, 2 and 3, 7, 5, after determining the 

radius R1 geometrically. 

  Project the view from the side and locate points 10, 11 and 12.  

  Mark points 13 and 14, lying at the middle of the two faces (view from the side).  

  Draw circular arcs passing through the points 10, 13, 11 and 11, 14, 12, after determining 

the radius R2 geometrically.  

It may be noted that in the view from the front, the upper outer corners appear chamfered. 

 

In the view from the side, where only two faces are seen, the corners appear square. 

 

Method 2 (Fig. 5.13) 

 

Empirical relations: 

 

Major or nominal diameter of bolt = D 

 

Thickness of nut, T = D 

 

 

Width of the nut across corners = 2 D 

 

Radius of chamfer arc, R = 1.5 D 

 



  

 

Figure 5.13 illustrates the stages of drawing different views of a hexagonal nut, following 

the above relations, which are self-explanatory. 

 

 
 

Fig. 5.13 Method of drawing views of a hexagonal nut (Method II) 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



  

 

 

 

Exercise No. 23 

 

Method of Drawing Square (Bolt Head) Nut 

 

A square bolt head and nut may be drawn, showing either across flats or corners. Following 

relations may be adopted for the purpose: 

 

   

 Major or nominal diameter of  bolt = D 

 Thickness of nut, T = D 

 Width of the nut across flats, W = 1.5 D + 3 mm 

 Radius of chamfer arc, R = 2 D 

Figure 5.14 illustrates the method of drawing views of a square nut, in two orientations. 

 

 
 

 
Fig.5.14 Method of drawing the views of a square nut 

 

 

 

 

 

 

 

 

 



  

 

 

 

 

Hexagonal and Square Headed Bolts 

 

Figure 5.15 shows the two views of a hexagonal headed bolt and square headed bolt, with the 

proportions marked. 

 

 
 

 

Square Headed Bolt with Square Neck 

 

It is provided with a square neck, which fits into a corresponding square hole in the adjacent part, 

preventing the rotation of the bolt (Fig. 5.18). 

 

 
 

Fig. 5.18 Square headed bolt with square neck 



  

 

 

Eye Bolt 

 

In order to facilitate lifting of heavy machinery, like electric generators, motors, turbines, etc., eye 

bolts are screwed on to their top surfaces. For fitting an eye bolt, a tapped hole is provided, above 

the centre of gravity of the machine (Fig. 5.21). 

 

 

 

 
 

Fig. 5.21 Eye-bolt 

 

Stud Bolt or Stud 

It consists of cylindrical shank with threads cut on both the ends (Fig. 5.22a). It is used where 

there is no place for accommodating the bolt head or when one of the parts to be joined is too 

thick to use an ordinary bolt. 

 

The stud is first screwed into one of the two parts to be joined, usually the thicker one. A 

stud driver, in the form of a thick hexagonal nut with a blind threaded hole is used for the 

purpose. After placing the second part over the stud, a nut is screwed-on over the nut end. It is 

usual to provide in the second part, a hole which is slightly larger than the stud nominal diameter. 

Figure 5.22b shows a stud joint. 

 

 

 

 



  

 

 
                                                 Fig. 5.22 (a)–Stud,  (b)–Stud joint 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



  

 

 

Other Forms of Nuts 

Flanged Nut 

This is a hexagonal nut with a collar or flange, provided integral with it. This permits the use of a 

bolt in a comparitively large size hole (Fig. 5.23a). 

Cap Nut 

It is a hexagonal nut with a cylindrical cap at the top. This design protects the end of the bolt from 

corrosion and also prevents leakage through the threads. Cap nuts are used in smoke boxes or 

locomotive and steam pipe connections (Fig. 5.23b). 

Dome Nut 

It is another form of a cap nut, having a spherical dome at the top (Fig. 5.23c). 

Capstan Nut 

This nut is cylindrical in shape, with holes drilled laterally in the curved surface. A tommy bar 

may be used in the holes for turning the nut (Fig. 5.23d). Holes may also be drilled in the upper 

flat face of the nut. 



 

 

Exercise No. 24 

 

 

 
 

 

 

d - Capstan nut e - Ring nut f - Wing nut 

 

Fig. 5.23 Other forms of nuts 

 

 

 

 

 

 

 

 

 

 

 



 

 

 

 

Week-VI   KEYS AND COTTER JOINTS 

 

 

 
 

 

 

 

 

 

 

 

 



 

 

 

 

 

 
 

 

 



 

 

 

 

A cotter is a flat wedge shaped piece, made of steel. It is uniform in thickness but tapering in width, 

generally on one side; the usual taper being 1:30. The lateral (bearing) edges of the cotter and the bearing 

slots are generally made semi-circular instead of straight (Fig. 1.0). 

This increases the bearing area and permits drilling while making the slots. The cotter is locked in position 

by means of a screw as shown in Fig. 1.1. 

 

Cotter joints are used to connect two rods, subjected to tensile or compressive forces along their axes. 

These joints are not suitable where the members are under rotation. The following are some of the 

commonly used cotter joints: 

 

 

 

 

 

 

 

 

Fig. 1.0 Cotter and the bearing slot Fig. 1.1 Locking arrangement of cotter 

 

Cotter Joint with Sleeve 

 

This is the simplest of all cotter joints, used for fastening two circular rods. To make the joint, the rods are 

enlarged at their ends and slots are cut. After keeping the rods butt against each other, a sleeve with slots is 

placed over them. After aligning the slots properly, two cotters are driven-in through the slots, resulting in 

the joint (Fig. 1.1). The rod ends are enlarged to take care of the weakening effect caused by the slots. 

The slots in the rods and sleeve are made slightly wider than the width of cotter. The relative 

positions of the slots are such, that when a cotter is driven into its position, it permits wedging action and 

pulls the rod into the sleeve. 

 

 

 



 

 

Exercise No. 25 

 

Draw the sectional view from the front, and view from the side of a cotter joint with sleeve 

used to connect two rods of 50 mm diameter each. 

 

 

Fig. 1.2 Cotter joint with sleeve 

 

 

 

 

 

 



 

 

Exercise No. 26 

Cotter Joint with Socket and Spigot Ends 

This joint is also used to fasten two circular rods. In this, the rod ends are modified instead of using a 

sleeve. One end of the rod is formed into a socket and the other into a spigot (Fig1.3) and slots are cut. 

After aligning the socket and spigot ends, a cotter is driven-in through the slots, forming the joint. 

        Draw the half sectional view from the front, with top half in section and the view from the side of a 

cotter joint with socket and spigot ends, to connect two rods of 50 mm diameter each. 

 

 
 

 
Fig. 1.3 Cotter joint with socket and spigot ends 

 

 

 

 

 

 

 

 

 

 

 



 

 

Knuckle Joint 
 

A knuckle joint is a pin joint used to fasten two circular rods. In this joint, one end of the rod is formed 

into an eye and the other into a fork (double eye). For making the joint, the eye end of the rod is aligned 

into the fork end of the other and then the pin is inserted through the holes and held in position by means 

of a collar and a taper pin (Fig. 1.4). Once the joint is made, the rods are free to swivel about the 

cylindrical pin. 

Knuckle joints are used in suspension links, air brake arrangement of locomotives, etc. 

 

 

 
Fig.1.4 

 

 

 

 

 

 

 

 

 

 

 

 



 

 

Exercise No. 27 

 

            Draw a Knuckle joint with 50 mm diameter (D) 

 

 

 

 
 

Fig. 1.5  Knuckle joint 

 

 

 

 

 

 

 

 



 

 

 

Exercise No. 28 

Week-VII       Riveted Joints 

 

 

 
 

 

Riveted Joints 

 
 



 

 

 

 
 

 

 

 

 
 

 

 



 

 

 
 

 
 

 



 

 

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 

 

 

Week-VIII        Couplings 

 

Shaft couplings are used to join or connect two shafts in such a way that when both the shaftsrotate, they act as  

one unit and transmit power from one shaft to the other. Shafts to beconnected or coupled may have collinear  

axes, intersecting axes or parallel axes at a smalldistance. Based on the requirements, the shaft couplings are 

classified as: (i) rigid couplings,(ii) flexible couplings, (iii) loose or dis-engaging couplings and (iv) non-aligned 

couplings. 

 

 

  

 



 

 

 

  

 

Oldham’s coupling 

 

 

 

 



 

 

Exercise No. 29 

 

 

 

 



 

 

Exercise No. 30 

 

 

 

Solid flanged coupling 

Draw (a) half sectional view from the front, top half in section and (b) view from the side of a 

bushed pin type flange coupling, indicating proportions to connect two shafts, each of diameter 

30 mm. 

 

 

 

 

Bushed pin type flanged coupling 

 



 

 

Exercise No. 31 

 

 

 

 

                                                                           Universal coupling 

 

 

 



 

 

Exercise No. 32 

Week-IX   Bearings 

Bearings are supports for shafts, providing stability, and free and smooth rotation. The importance of 

bearings may be understood from the supporting requirement of machine tool spindles, engine 

crankshafts, transmission or line shafts in workshops, etc. Bearings are broadly classified into two 

categories: sliding contact bearings and rolling contact bearings or antifriction bearings. 

 

Journal Bearings 

 

Fig. 1.0 Solid journal bearing 

 

Fig. 1.1 Bushed journal bearing 



 

 

Exercise No. 33 

 

Pivot or foot-step bearing 

This bearing is used to support a vertical shaft under axial load. Further, in this, the shaft is terminated at 

the bearing. The bottom surface of the shaft rests on the surface of the bearing which is in the form of a 

disc. The bush fitted in the main body supports the shaft in position and takes care of possible radial loads 

coming on the shaft. 

 

 

 

 

 

 

 

 

 

 



 

 

 

 

Draw (a) sectional view from the front and (b) view from above of a foot-step bearing with radial 

               and thrust ball bearings, suitable for supporting a shaft of diameter 60mm. 

 

 

Fig. 1.2 Foot-step bearing 

 

 

 

 

 

 



 

 

Collar thrust bearing 

This is generally used for supporting a horizontal shaft under axial load. Further, in this, the shaft extends 

through and beyond the bearing. The shaft in a collar thrust bearing may consists of one or more collars 

which are either fitted to or integral with the shaft (Fig. 1.3). The collars rotate against the stationary split 

bearing surfaces. 

 

 

 

Fig. 1.3 (a) Single collar bearing, (b) Multi-collar bearing 

 

 

 

 

 

 

 

 



 

 

Exercise No. 34 

Week-X Assembly Drawings 

                                        ENGINE PARTS   
 

 Assembly of Stuffing Box 

 

It is used to prevent loss of fluid such as steam, between sliding or turning parts of machine elements. In a 

steam engine, when the piston rod reciprocates through the cylinder cover; stuffing box provided in the 

cylinder cover, prevents leakage of steam from the cylinder. 

 

Figure 1.0 shows the various parts of a stuffing box. At the base of stuffing box body 1, a bush 3 is 

placed such that the bevelled edge of the bush is at the inner side of the body. Gland 2 is placed at the other 

end of the body and is connected to the main body by means of studs 4 and nuts 

 

 The space between the reciprocating rod and the bush and the gland is packed with a packing material such 

as mineral fibres, leather, rubber or cork. 
 

Exercise 

Assemble all parts of the stuffing box for a vertical steam engine, shown in Fig. 1.0 and draw, (i) half 

sectional view from the front, with left half in section, (ii) half sectional view from the right and (iii) view 

from above. 

                                         Stuffing Box Assembly 

 

 

 

 



 

 

 

 

                                                            Fig. 1.0 Stuffing box 

 



 

 

Exercise No. 35      Assembly of Connecting Rod 

 

 

 

Exercise No. 36         Assembly of eccentric    

The details of an eccentric are shown in Fig. 2. Assemble the parts and draw, (i) half sectional 

view from the front, with top half in section, (ii) view from the right and (iii) view from above. 



 

 

  

Assembly Model of an Eccentric  

 

 



 

 

 
 

 

Assembly Drawing of an Eccentric  

 

 

 
 

 

 

 

 

 

 

 

 

 

 

 

 

Exercise No. 37       Assembly of Screw Jack 

 



 

 

 
Screw Jack Assembly 

 
Exercise No. 38       Assembly of Machine vice  

 



 

 

 
 

 

Assembly Drawing :  

 
 

 

 

 

Exercise No. 39       Assembly of lathe tailstock 



 

 

 

Tail Stock Assembly 

                                            

Exercise No.40       Assembly of Ramsbottom Safety Valve  



 

 

 

 

Assembly Of Ramsbottom Safety Valve 

 

 

Exercise No.41       Assembly of Feed Check Valve  



 

 

 

 

 

Feed Check Valve Assembly 

 


